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This guide presents an overview on how to set up and configure Sync for QuickBooks to
synchronize transactions to your QuickBooks account. The guide covers setup instructions for
existing users of QuickBooks only.

QuickBooks is a registered trademark of Intuit, Inc.
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Introduction

Welcome to the setup and configuration guide for Sync for QuickBooks. We have worked
hard to make Sync for QuickBooks as intuitive and user friendly as possible, however, we
know that you may still have questions.

This guide provides an overview and step-by-step instructions of how to set up Sync for
QuickBooks for existing users, allowing you to synchronize your Authorize.Net transaction
data with your QuickBooks account. We encourage you to read this guide thoroughly to
familiarize yourself with the requirements.

Requirements

Before beginning the setup process, we recommend that you have an existing, active Intuit
QuickBooks account, either QuickBooks Online or QuickBooks Desktop version. If you do
not have an existing QuickBooks account, please visit the Intuit QuickBooks website to
create an account.

Note: Intuit QuickBooks Online is a monthly, fee-based subscription service, which is in
addition to the Sync for QuickBooks service offered by Authorize.Net.

For QuickBooks Online Users

¢ You will need the username and password used to log into your QuickBooks Online
account. These credentials will be used to identify the account that we will
synchronize your transaction data with.

e Make sure you set up and configure QuickBooks with your actual company name,
services, payment types and customers before using the Sync for QuickBooks
service. This information will be used to map the transaction data to your account. If
the information is not present, default information will be created as part of the
account setup process.

For QuickBooks Desktop Users

e Set up and configure QuickBooks version 2009 or newer with your actual company
name, services, payment types, and customers. This information will be used to map
the transaction data to your account. If the information is not present, default
information will be created as part of the account setup process.

e Make sure you are up to date on maintenance releases (Help > Update QuickBooks)

e Enable Sync Manager (File > Sync > Launch Intuit Sync Manager)

e Enter the username and password created for Sync Manager. These credentials
identify the account to be used to synchronize the transaction data with.

For more information on Intuit Sync Manager, click here:
http: //support.quickbooks.intuit.com/support/Articles /INF12843

Sync for QuickBooks Setup for Existing QuickBooks Users
To enable the Sync for QuickBooks service with Authorize.Net:
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Step 1: Log into the Authorize.Net Merchant Interface.

Please Log In!
Login ID:

Forgot Your Login ID?
Password:

Forgot Your Password?

Step 2: Select Sync for QuickBooks from the left navigation menu.

HOME TOC

Virtual Terminal | Unsettied Transactions

ANNOUNCEMENTS

82112

There are no new announcements at this
time.

TOOLS

Virtual Terminal

Upload Transactions

Recurring Billing

Fraud Detection Suite
Customer Information Manager
F~

laChaal s

Sync for QuickBooks™

REPORTS
Transaction Detail

Step 3: Select the Get Started link from the Sync for QuickBooks service home page.

Syne for QuickBooks Help

Save valuable time and money by automnatically importing your settled Authorize Met transactions directly into your existing QuickBooks
account. Setup is simple and only requires a one-time configuration.

Features and Benefits

&« Automatically sync your daily transactions with QuickBooks
» Save time and eliminate the errors that come from manually keying in transaction information
« Simple and automatic setup, or customize for your unique business requirements

Get started using Sync for QuickBooks

Step 4: Review the Terms of Service.

Step 5: Check the box to confirm that you have read and understand the Terms of Service.

Step 6: Click the I Agree button to proceed.
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[¥1i'have read and understand the Terms of Senvice:

| Decline |

Step 7: Once you have reviewed the requirements, click the Connect to QuickBooks
button.

Note: You must allow pop-ups from Intuit in your browser settings to continue the setup
process.

Sync for QuickBooks™ Help

Activate Sync for QuickBooks!
QuickBooks &

Why do | have to do this? Additional information for QuickBooks Desktop users.

Don't have a QuickBooks account? Sign up!

" ifuri,
QuickBooks
Online Essentlals

Note: If you do not have an existing Intuit account, you may click the Intuit QuickBooks
Online Essentials icon and proceed with creating a new QuickBooks Online account.
QuickBooks Online requires a subscription service with Intuit. Upon completion of account
setup, return to Step 7 and continue the configuration process.

Step 8: Enter your QuickBooks login credentials and click the Sign In button to approve
synchronization of data from Authorize.Net to your existing Intuit account.
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INTUIT. Account Create Sign In

Sign in with your Intuit Account or create one.

|U5er ID or Email Address

I Password

Remember me

| Sign In |

—

Authorize.Net

Note: If your existing QuickBooks user credentials are associated to a desktop version of
QuickBooks and you have not set up Intuit Sync Manager, you will need to configure these

settings before continuing.

InTuIt Welcome, John Tester

Go to QuickBooks and sync your data

In order for DEV 01 QB to work properly, you must use your own company data.

Sync Status: @ Pending

Follow these steps to sync your data: Edit View Lists Favorites ¢
. New Company...
1. Go to QuickBooks. Open your company file. el —
2. Choose File > Set Up Intuit Sync Manager. Open Previous Company
3. Sign in with your Intuit account if you haven't already Switch to Multi-user Mode
done so. Remote Access
Utilities

Problems syncing?
2 T

Come back after Intuit Sync Manager is done syncing. Set Up Intuit Sync Manager

Step 9: Once the page refreshes, click the Complete Registration button.

Completing Sync for QuickBooks Activation...

If this window does not close automatically, click here to close.
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Sync for QuickBooks™*

Sync for QuickBooks Activation Success

YouTe almostfinished! Please review the information provided and click the Complete Registration button below to complete

Sync for QuickBooks signup.

What to Expect

Yourtransactions appear as Invoices in your QuickBooks file with Payments applied to them.

Invoices are applied to "Accounts Receivable™ and Payments are applied to a "Sales™ account. If either one did not

dy exist, we created it for you.

We created a Sync for QuickBooks Customer and Item in your QuickBooks to use with Invoices and Payments.

QuickBooks Desktop Users:

Sync Manager must be activated for payments to appear in your QuickBooks.

Complete Regisiration

Help

Authorize.Net

Note: A generic customer (Sync for QuickBooks Customer) will be created in your QuickBooks
account. All transactions will be assigned to this customer when synchronized from
Authorize.Net to your QuickBooks account. You can change the default customer once you
have completed the registration process.

Setup of Sync for QuickBooks is now complete and, by default, transactions from your last

successfully settled batch will be synchronized to your QuickBooks account.

Next you will be redirected to the Sync for QuickBooks dashboard. The Sync for
QuickBooks dashboard allows you to correct data sync errors, modify the default account
mappings or disconnect your Authorize.Net account from the QuickBooks company you
just established.

Dashboard

Sync for QuickBooks™

Write Errors
You have no write errors.

Configuration Settings
Manage the default values used to reconcile transactions.

QuickBooks Connection
Manage your QuickBooks connection here.
Your stored QuickBooks credentials will expire on 3/5/2014.

Help

| infurt. © |

Here you can manage write errors and update your service configuration. If you have QuickBooks Desktop, you
can also check the synchronization status of payments.
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How to Correct Write Errors
There may be instances where we were unable to synchronize your transaction data to
QuickBooks. In such cases, these synchronization errors will appear under the Write
Errors menu. To modify the record or attempt to resynchronize the record, click the Write
Errors menu and modify the record to resubmit.

e Write Errors

You have 10 write errors.

B | 2148807921
[ | 2148808038
| 9442207097

Write Error Transaction ID

Document Number Error
4:38:50 PM.1503 990
4:38:50 PM.4564 990
4:38:50 PM.8165 990
4:38:51 PM.5087 350
4:38:51 PM.8578 990
4:38:51 PM.1156 990
4:38:48 PM.8800 990
5:05:40 PM.3640 990
4:38:49 PM.4851 930

Amount

$10.00

$10.00

$10.00

$10.00

$10.00

$10.00

$10.00

$10.00

$10.00

Timestamp

8/5/2013 11:38:50 PM

8/5/2013 11:38:50 PM

8/512013 11:38:51 PM

8/5/2013 11:38:51 PM

8/512013 11:38:52 PM

8/5/2013 11:38:51 PM

8/5/2013 11:38:49 PM

8/6/2013 12:05:40 AM

8/5/2013 11:38:48 PM

Payment Amount

Payment Timestamp

Currency

Document Number

AR Account

Customer D

tem

Deposit Account

Payment Method

4:38:49 P11 4851

Accounts Receivable (AR

Services
Checking

Visa

Update & Hetry Payment

Update detads using the field below and cick Update and Retry Payment. A success or fadure message plus new
error status will appear.

How to Modify Configuration Settings
The Configuration Settings menu allows you to modify the default account mappings
assigned when the service was initially created. The accounts listed in each drop-down
show what account mappings are available at that time. If you wish to use a different
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account mapping and the selection is not available in the drop down, you will need to go to
your QuickBooks account and create a new account type, then return to this menu and
modify the mapping via the drop-down selection menu. Following any modification to the
mappings, click the Save Configuration button.

E‘} Configuration Settings
Manage the defaull valpes used to reconcile transactions

Dashboard | Configuration

The values in the fields below are used to auto-reconcile payments
upon your current QuickBooks Information. Changes to your service

AR Account Accounts Receivable (=)
Payment Method Check [L
Deposit Account Chevy Chase Bank [+

Default Customer Authorize net E

Dé{‘jult Item Legal Services t

| Save Configuration ICancel

How to Disconnect Your QuickBooks Account from Sync for QuickBooks

The QuickBooks Connection menu allows you to disconnect your QuickBooks account
from the Sync for QuickBooks service. This may be useful if you create a new QuickBooks
account, and you want to synchronize transaction data to this new account. This menu
should not be used if you want to temporarily stop synchronizing transaction data, which
can be done via the Sync for QuickBooks Settings page noted below. It should be noted
that once you have disconnected your QuickBooks account from the synchronization
service, you will need to complete the setup process again to reestablish a connection.

) QuickBooks Connection
Manage your QuickBooks connection here

Your stored QuickBooks credentials will expire on 3/5/2014

How to Modify Transaction Synchronization Settings

By default, the synchronization of transactions will begin using your last successful batch of
settled transactions. To modify the default configuration, click View Settled Transaction
Synchronization Settings under the Settings section of the Sync for QuickBooks
dashboard and click the Submit button when completed.
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Sync for QuickBooks™ Help

Dashboard ‘ infuit. °|

Here you can manage write errors and update your service configuration. If you have QuickBooks Desktop, you can
also check the synchronization status of payments.

Write Errors
You have no write errors.

‘ Configuration Settings

Manage the default values used to reconcile transactions.

( } QuickBooks Connection
Manage your QuickBooks connection here.
Your stored QuickBooks credentials will expire on 6/16/2014

Settings

View Settled Transaction Synchronization Settings
gs used for the synchronization of your transactions in QuickBooks™.

Discontiue Sync for QuickBooks ™ Semice
Terminate your Sync for QuickBooks™ Senvice agreement.

Changing synchronization to specific date.
Choose a settlement batch date from the Synchronize from a specific date drop-down list
and click the Submit button to save.

Syne for QuickBooks™" Settings Help

By default, the start date for synchronization is set to the service activation date. However, you may choose to synchronize from a
specific date by selecting one from the drop-down menu below. You can also choose to synchronize all your settled transactions or
disable synchronization. Select an option below by clicking the radio button next to your choice. Then click Submit.

NOTE: Authorize.Net is not currently synchronizing your settled transactions with QuickBooks. If you would like Authorize.Net to
synchronize your settled transactions with QuickBooks, please choose one of the selections below. In order for Authorize.Net to
sucessfully synchronize your settled transactions with QuickBooks, you must first connect your Authorize. MNet account with QuickBooks.

@ Synchronize from a specific date: | [EEASARERINAZE] v

©) Disable synchronization with QuickBooks

Return to Settings

Synchronize all successfully settled transactions
Select the radio button for Synchronize all my settled transactions and click the Submit
button to save.
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Sync for QuickBooks™ Settings Help

By default, the start date for synchronization is set to the service activation date. However, you may choose to synchronize from a specific
date by selecting one from the drop-down menu below. You can also choose to synchronize all your settled transactions or disable
synchronization. Select an option below by clicking the radio button next to your choice. Then click Submit.

Return to Settings

Disable synchronization with QuickBooks

Authorize.Net

This setting is used to stop the synchronization of data between your Authorize.Net
account and your QuickBooks account. A change to this setting does not terminate or cancel

the Sync for QuickBooks service.

Select the radio button for Disable synchronization with QuickBooks and click the

Submit button to save.

Sync for QuickBooks™ Settings Help

By default, the start date for synchronization is set to the service activation date. However, you may choose to synchronize from a specific
date by selecting one from the drop-down menu below. You can also choose to synchronize all your settled transactions or disable
synchronization. Select an option below by clicking the radio button next to your choice. Then click Submit.

© Synchronize from a specific date:

@ Disable synchronization with QuickBooks ™

Return to Settings

How to Terminate Sync for QuickBooks Service

To terminate the Sync for QuickBooks service with Authorize.Net, click Discontinue Sync
for QuickBooks Service in the Settings section of the Sync for QuickBooks dashboard and

click the Yes button to confirm cancellation.

Note: Cancellation of the Sync for QuickBooks service with Authorize.Net will not cancel any
subscription service you may have for QuickBooks Online with Intuit. To reestablish the Sync

for QuickBooks service, you will have to complete the setup process again.

© 2014 Authorize.Net
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Sync for QuickBooks™ Help

Dashboard ‘ infuit e‘

Here you can manage write errors and update your service configuration. If you have QuickBooks Desktop, you can
also check the synchronization status of payments

Write Errors
You have no write errors

" Configuration Settings

Manage the default values used to reconcile transactions

_ ) QuickBooks Connection
Ay Manage your QuickBooks connection here
Your stored QuickBooks credentials will expire on 6/16/2014

Settings

View Settled Transaction Synchronization Settings

nsactions in QuickBooks™

Discontiue Sync for QuickBooks™ Semvice
Terminate your Sync for QuickBooks™ Service agreement

Discontinue Sync for QuickBooks™ Service Help

WARNING: By clicking Yes, you are requesting to discontinue your Sync for QuickBooks™ Senvice agreement. The service will no longer
synchronize transaction data between the Payment Gateway and the service. If you would like to reactivate the Sync for QuickBooks™
Senvice, you will need to attain a new license with QuickBooks ™.

Do you wish to continue?

[ Yes ] No

Return to Dashboard

Data Mapping Between Authorize.Net and QuickBooks

Data mapping between Authorize.Net and QuickBooks is as follows:

Authorize.Net Data QuickBooks

Transaction Date Time Stamp Date

Customer Sync for QuickBooks
Customer (default)

Amount Amount

Payment Method Payment Method

TransactionID (also listed as Document | Ref #
Number within the Write Errors menu)

Invoice # (if present) Memo
Customer ID (if present) Memo
Purchase Order (if present) Memo

Authorize.Net

The QuickBooks memo field will list the Authorize.Net Data in the following order: Invoice

#, Customer ID, Purchase Order.
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